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Abstract
A problem-solving environment called WISE uses object oriented software design to link research models from
various subdisciplines for mag comprehensig eosystem simulation and visualization. A simulation manager
component usea dock to contrd the coupling mechanism, allowing dynamic querying between encapsulated
models for the most recent values of state variables. Case studies are given which describe the potential use of this
tool for ecological research.

Introduction
As human activities pervasively alter the physical systems that $uifpasn eartH, we face the difficult scientific
problem of predicting how terrestrial ecosystems respond to global change. The most reliable information we have is
for near-term responses measurable by short-term experiments. For example, pores in the leaves of plants in forest
canopies close or open as concentrations of carbon dioxide in the local air rise or fall. Leaves may experience daily
changes in the level of external Cthat are as great as changes expected in the free atmosphere from the burning of
fossil fuels over the next few decadese \é measure the rapid response of leavedatly change; however, this
near-term response maytrtell us much abduthe long-term effects of chronically high ¢@vels, nor abaduthe
reliability of ecological simulations designed to predict long-term respgonse.

To exter our knowledge beyond experimentally tractable short-term physidspaysiology to the long-term
responses of whole terrestrial ecosystems, researchers construct process-oriented simulation models. Some tested
computer applications of limited scope and predictive ability are already in regular use for ecological forecasting and
environmental management. For many purposes, though, we are still at an earlier stage, using computational systems
to researcthow to model ecology. Good research models can demonsteatfdbts of iwha ifi assumptions and
hypotheses and help frame further questions, whittH @ad o better models and eventually to tested applications

for routine use.

What makes good ecological modeling so difficult, and what makes the building of computational systems to further
this goal such a challenge as well, is #adsystems are immensely compldsey include millions of entitieséliving

species, chemical compounds, forms and fluxes of energy6and innumerable interactions among these factors.
Ecological modeling always becomes an exercise in simplification and approximation. What must we include? What
can we leave out?

Exploratory Simulation Using Coupled Models
Different scientific discipline sudying ecosystems emphasize different structures, details, and theories in their
models. When approaching questions that cross discipitrisseldom clear tithe outset whether detail ceritta
the gproach of one discipline (suck ail physics) is importainto dynamic responses ofdhre@system a gudied
by another discipline (such as plant physiology). However, including all the latest theories and potentially important
details in a single model would make that madé&actable for analysis, and the comprehensive input data required
would rarely even & available. Moreover, ifa complex ecological model simultaneously embodied untested
theoretical innovations from several disciplines, assessing the validity of any one of them would be difficult.

General Strategies for Coupling Models

There is no single accepted approach to coupling complex models. Some have taken the stance that already complex
models are likelyd become intractable when coupled to each other. Nonetheless, akeviable tactics for
selectively coupling models to study or include particular effects, as shown in Figure 1.




One strategy (case 1, Figure 1) is to use one model, say Model B, as a source of data to estimate the parameters of
some function to be embedded in Model A, a model that is to be changed or improved. Here the role of the model is
similar to ecological field data that need to be approximated as a function of other variables. Similarly, in a modeling
environment, Model B could provide simulated states or boundary conditions dynamically to Model A (case 2). This
resembles providing Model A with a time series of observations. In both cases2]l Model B may k @le to

provide information for a broader range of circumstances than available observations can.
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Figure 1. Four methods of coupling the behavior of one model (A) to information simulated with another (B).

In ecosystm modeling, once detail about a subsystem has proved important for answering a question, the usual
approab has been to embed some version of Model B into Model A (case 3). This approach is valuable if the
models are theoretically compatible, if the models have appropriately nesting representations of time and space, and
if the resulting enhanced Model A remains tractable for analysis and use.

Two-way dynamic coupling of separate models can address the situation (case 4) when detail that is important to one
scientific disciplire dfects tte answers & questions aske by another. With the proper simulation environment,
sufficiently shot time steps, and attention to error propagation and the dynamical consequeneesonplihg,

models which may or may not be theoretically, temporally, or spatially compatible can be coupled to answer specific
guestions.

The WISE Problem-solving Environment




To hep overcome the obstacles of linking models grerforming coupled simulations, we have developed a
problem-solving called the Workbench for Interactive Simulation of Ecosystems (WISE). WISEeauigagrdach
described in Case 4 (Figure 1), because of its power and flexibility in dealing with complex ecological questions.

WISE lets researcherslectively tes the dfect of supplying @ one disciplineis modethe mmplex behavior
believed © be important by experts in another discipline. Visualization toots amdemand logging of results to
files let the researcher both see the possible effect and perform further analysis of the results.

If testing with tle coupled models shows that a particular simulated effeanportant, then representing it on a
routine basis becomes a research problem for the modelis authoréjust as if experimental work or new theoretical
developments withi her discipline suggested éhchange. WISE adds to the dialogue between disciplines by
providing an avenue for transferring insights among them. This approach is part of an ongoing project, an outgrowth
of research into combining models from different disciplines and of applying concepts from object-oriented software
design to the reuse of ecological simulation motiéls.

Developing System Requirements
When determining what we wanted WISE lie ale © do and how, we had to consideretlapplication domain,
several issues of overall architecture, and the useris need for effective visualization.

Domain Requirements

WISE is designed to simultaneously run a variety of ecological models, or multiple instances of a particular model,
for a specified simulation period. We achieved this by creating a coupling mechanism that allows any model instance
to query another modeénstance dynamically for the most recent values &#te variables. For example, a soil

model coutl be linked to a model of canopy growth with minimal effort, and thencnopy model could use the
reported soil conditions to improve its calculations.

Because WISE is a research tool, we designed it for flexibility. For instance, models using various time steps need to
run simultaneously:rahourly model might need to run in tandem with a daily model. Moreover, we wanta t

sure that scientists could tetheir hypotheses by modifying the internals of the model. With such a feature, a
compiled imicroversiont of the original could then be executed using the existing interface.

A user interface that gives common look and feel across disparate models was tritichiding the inherent
complexity of a multimodel application, especiallycgneab modé type has its ow urique set-p parameters,

constraints, and input files. Shared visualization toolewso neededa provide dynamic displays for monitoring
selected attributes during a simulation run.

A simple encapsulation processrfounning a legacy model within éhgoplication was neededBy encapsulating a

legacy model within an object oriented model class, aan hide implementation details and erfer @mmon

behavior between different mddiggpes The dass also allows access to the models' state variables, which are
needed for visualization and intermodel exchanges. At the same time, the encapsulation process must be light-weight
and minimally intrusive to the model's n&iwde This reduces # dfort to encapsulat a model and helps
minimize tke chances of introdung rew softwae arors Furthermore, as researchers release new versions and
revisions of their models throughout most development projects, updates enessilp incorporated, or the
application will fall behind the state of the art in ecology.

WISE also allows for multiple levels of human expertéed interaction, including canned configurations to help
novice users learn how to use the models and the PSE, while retaining flexibility for the expert.

Architecture Requirements

The fird issue in designing the systemis architecture was careful management of compoeces. Often
simulation modeling is very CPU-intensive, especially when many model instances are running simultaneously. Input
and output files can be very large and require lots of disk space. Therefore, the system had to efficiently scale up to
large simulations.




Complex configurations of models might run for hours or days on a single researcheris problem, implying a need for
a multi-user environment. ¥ aldressed this ndeby creating separate workspaces for each researcher and
maintaining them with proper user authentication.

Interprocess communication is essential since the models mubiebto exchange data. In WISE, actionsbe
taken by an object are requektey event-driven communications, and synchronized message passing is used to
exchange deterministic results between processes.

Finally, we wanted WISE to be easily portable. We enhanced portability by isolating language-dependent extensions
and system-level access, and by avoiding proprietary software packages.

Visualization Requirements

We wanted WISE to provide both real-time feedback with the ability to track the evolution of a quantity in time, and
a facility for postprocessing of numerical results from the simulation. Given the masgunts of data generated

by the encapsulated models, that meant we needed both visual displays and utilities for generating data files.

WISE includes a time-filtering option to compare resultsnfrmodels running at differéniime steps. For example,

when running a hourly model and a daily model simultaneously, a researcher may wish to compavertige

daily value of attributes from the hourly model with the daily model. In some cases, she may want to compare several
configurations of a modaype or tle dfect different models have on a given attribute. Multimodel reports allow
easy comparison of attributes from differémstances. In addition, some specialized ismarti graphics reporters get
the information they need directly from particular models without burdening the simulation manager with this task.

Software Design of WISE
An object oriented approach was chosen to implimiba design in orderotbest achieve the goal of minimal
encapsulation effort when a new model is added or an existing model is updated. When a new model is encapsulated
into WISE, te dass s$ructures enforce uniform behavior between nhdgges and allow for maximum code reuse
between models. Each encapsulated model inherits its behavior from a base class, which forms a common interface
between all model types and WISE. Therefore, as the WISE design evolves, modifications need to be made only to
the bae dass, and the motles modified only to the extent of encapsulation into the leadass A set of tools for
each modetype was needed to adsis configuring input data to a model ruRational Roseéwas usedd design
and engineer an OO solution bltain maximal reus and functionality Therefore, v ae @le to minimize the
encapsulation process and reduce intrusions into the native model.

To dstribute heavy processing, graphical displayd disk storage to the most appropeabmputer, ve chos a
client-server architecture. Collaborating computers pass set-up files and results using remote procedure calls. Figure
2 displays an overview of the major components of the design and their interactions.



;

Figure 2. Context diagram of WISE, displaying major client and server entitiesafidws indicate directional
information flows.

Model processes are needed to report state informatiothér coupled models or for visualization.eVidieved
this using message queues for interprocess communication on the same host. An IPC messaipss)|weas
written to hide message-passing complexities.

The Standard Template Librdrig used in WISE as an important tool for storing and magagirious objects and
object types, without adding significant development costs.

Graphical User Interface

The domain requirements for ease of use lead naturally to a graphical user interfacdiefithserver
implementation allows the models to execute on a powerful computing server while maintaining the fast response of
a local GUI. Since the system supports a wide variety of models, the GUI desigrenabls to extratthe issues

shared by all models and present a common interface to the researcher.

The basic tasks to do for a simulation are

(1) select the model(s),

(2) set up or configure the model(s),

3) set up reports for desired model results, and
(4) interact with the simulation itself.

The tasks are the same for all models, although the options available for configuration and reports are model-
specific. We adressed this by a tietedesign that distinguishes between simulation-level and model-level options.

The main window, which remains visible throughdhe simulation, provides an overview of the system options,
system status, and access to simulation control (run, suspend, resume, reset, and halt). The Motif-style menu bar
offers File, View, Models, Control, and Help options. Selecting a riodekes a similar window, the model main
window, with options of File, View, Configure, and Help, as shown in Figure 3. Then, these common top-level menu
choices cascade to model-specific options.
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Figure 3. A sample model configuration panel with soil data selected from a list of soil profiles and initial conditions
set for one soil layer.

Simulation-level Menus.A new simulation begins from the File menu. This is a fresh start with no models selected,
and the user first enters certain simulationdénéormatian via apop-up window. Alternatively, the Open option
restores a previously saved state of configured models and reports. This feature is very poaveduksare and

restoe a @mplex array of models and reports with a single user operation. This is valuable not only for saving time
but also for reliable duplication of results and for documentation of special multimodel system configurations. Save
and Save As options are available at any time in the simulation to save the current workspace information. This menu
also provides an Exit option from the simulation environment.

The researcher sets up multimodel reports through the View menu, which displays a list of configured models.
Selecting a model invokes that modelis specific attribute selection list, as well as the report selection options detailed

later.

The Models menu listsllathe available types of models dnprovides access to microversions\aremote file
selection box, which includes files onetltomputing serve rather than the local machine. When a model or
microversion has been selected, a model main window appears. One imodhelistes selected is the Framework.
Its role & pecid: it provides the simulation-wide settings that define ¢hntext for the rest of the models. The



Framework requires a valid user identifier o tomputing server, which permits user authentication and file
ownership for the simulation.

The Control menu includes the Run, Suspend, Resume, Reset, and Halt options, which are pasemdatitg
server to control the simulation. Reports may be added during a suspended state.

Model-level Menus.The File menu options include the steps needegrdpae amodel for simulation. The GUI

helps the researcher sequence through the steps properly by controlling the sensitivity of the menu options. For a new
model, the first choice is the model configuration. The Standard option yields a safe setting of model parameters; the
Open option allows the user to select an alternate set of parameters (saved from a previous work session). In either
case, the user can display and changeathociatd parameter values from éhonfiguration menu. Choosing Add

Model adds an instance of this model to the GUIis internal list, and initiates the steps needed to run it. The first step
is to validate the parameter settings against model-specific constraints. If the configuration is flagged as invalid, the
GUI will still keep track of the model but not complete the operationll ifsawell, the GUI will cresg amodel
initialization file in a model-specific format drpassit to the simulation manager. Sand Save As options allow

the configuration and reports information to be saved to a disk file for later use.

Adding a modkinstance to the simulation (thiz, creating and initializing a simulation process for the model and
configuration) enables the View menu, where the researcher may specify runtims segoras disk files and
stripcharts. Selecting a reporter type triggers a sequential display of dialog boxes that cue for reporting time interval,
attribute selection, and time-filtering options. These windows are generic, but the attribute list and level of reporting
vary among models. For instance, a soil model may have simulation-level attributes and attributes for discrete soil
layers. A dialog box will prompt for any additional information needed.

Every model has configurable items, but a simple model may onlg hdew grouped ird one initialization

window, while amore cmmplex model may have many items organized into several categories. In both cases the
Configuration menu item cascades to a list of that modelis configuration windows. Selection of a configuration menu
item displays a window showing the current settings of the parameters included under that heading. These items may
then be altered interactively, as shown in Figure 3.

GUI Implementation. The GUI developmeénitself was smplified by the use of TAE+, an interface builder
originally fundel by NASA.2 This tod is built on bp o Motif, and the runtime libraries are freely distributable,
allowing the application code to run on any Motif-compliant platform. TAE+ allows interactive widget layout, which
is perfect for rapid prototyping of the windows before doing any coding. This permits a fast validation cycle with the
model author for model-specific configuration windows.

Minimal coding effot is required to add a new made the GUI by the use of shared event handlers. While the
number of configurable items varies among models, the type of items does not. A relatively small set of widgets
handles the existing models, and every instance of a given widget uses the same event handler.

The most complex task associated with running a inedeonfiguring it properly. Since the GUI supports diverse
models, we decided to hide most model-specific information from it by developing a configuration tool as a back end
to the GUI. The model-specific configuration tool behaves as a database, with the added responsibilities of constraint
checking and creation of a model initialization file in the format required by the specific model type. The constraints
consist of rules and valid data ranges for initialization parameters. The configuration class accesses these constraints
from an externlatable & a set of rules abbthe parameters for a model, allowing revision of constraints without
having to rebuild the tool set. A reference to the set of constraints to enforce is part of each configuration. Each
configuration tobis a separate process that exists for the duration of the work session, and uses a unique message
gueue for communication on a per-model-instance basis. Eieme makes it easy to keep track of many models

and multiple configurations per model type, and greatly simplifies the GUI design.

One goal of the GUI is to makeethomplex model configuration process accessibledople who are not
completely familiar with the model. The organization o# ionfiguration windows aids this by organizing the
parameters in a logical manner (for example, all parameters dealing with a particular subsystem would be grouped in



a separate window). Each model has a default, or safe, configuration, whicle rdegnbed interactively through

the configuration windows. Simultaneously, the GUI maintains a dialogue with the configuration tool, apprising it of
the current values, and receiving notice of any constraint violations. If someone enters a value for a parameter that is
known to be outside its physical limits, a warning will appear in a separate window, allowing the user to undo or edit
the offending item.

Managing the Computations

An RPC daemo handles incoming client calls fmo multiple users. A second user-specific daemon process
maintains distinct workspaces for each user. This process leads to subsequent processes that are required to conduct
the simulation, as shown in Figure 2.

Simulation Manager.This process controls all model and reporting instances. Initially, it creates a work area for
each model instance and instantiates each model and reporter request. The simulation manager includes three classes
of reporters fo reporting specific state information for a particular Modestarce d specified intervals. File

reporters wrig dtribute values outo a file for possible postprocessing. Display reporters use visualization tools to
display their values. Intermodel reporters link models. A model instance may query an intermodel reporter to obtain
data from another model. Intermodel reporters are unique frthiéya are nbinitiated through the GUI but by a
configured model instance.

The manager contairs dock objed¢ that accesses a list of all configured models and reporters. When a run
command is issued, the clock negotiates the optimal clock step size based on the various step sizes of the configured
models and reporters. &dock broadcasts a step and step size to each model and reporter object. Each of these
objects determines if is appropriate foit to act on this particular clock step. Thee ttock checks the message

gueues for any requests rinanodels for sharing attribute values between models. After receiving acknowledgments
from all the models, the clock advances to the next step.

The researcher may suspend the simulation at the end of any clock step to add reporters or examine model output in
detail. If a display is no longer needed, the user can delete the stripchart and its reporter. Credélegiram of
stripcharts on the fly can be very useful as a diagnostic tool. There is also provision via the GUI to introduce a delay
between clock steps to pace output for easier comprehension.

Encapsulated modelsGenerally coding in Fortran, authors encapsulate their models into WISE by the following
steps. The model is modified to become a re-entrant subroutine which may be called at each time step. All loops with
time-related indices are replaced with conditional blocks based on the clock step. Procedural calls then are added to
updae dtribute values in the states database. &loals are aoded in Fortran 90 to allow for polymorphism based

on attribute type. The motles compiled with a Fortran 90 compiler and linked to a C++ layer, which supplies the
model class constructs. Models in other languages could use the same model class but would require new
interlanguag cdls. The model class enforces common behavior between all models and contains the repository of
model attributes that are available for external queries from reporters. Finally, a configuration tool for the GUI must
be created. The amount of effort required to encapsulate the model varies widely, depending on the complexity of the
model and its initial inputs, but typically these steps can be achieved with a few days of effort.

WISE allows the researcher the flexibility to create variants of the default encapsulated model. These microversions
are differem in tha the researcher provides an absolute path to thénitialization. They may atsdiffer from the

default modein the dtributes available, # dgorithms used for particular ecosystem processes, or in coupling to
other models via intermodel queries.

Visualization Tools

Each model manages its own list of attributes, or reportable state variables. A user can request this list from the GUI
dynamically at runtime, when each attribute is available for reporting in several forms. Generating a reporter request
formalizes the selection of one or several attributes for feedback. Eacht risqses to the simulation manager,

which creates a reporter to gather the information froengipropriate models at runtime. The GUI provides a
sequence of pop-up windows to help the reseanefipiest a reporter with the desired reporting options, including
attribute selection and time filters. The selected attributes may be written to a disk file for postprocessing offline, or




reported live graphically as the simulation runse Wncentratd development efforts on the stripchart, which
permits smultaneous display of multiplatributes ona wmmon scale, and scrolls over time. However, the object-
oriented design of the graphics software permits adding more visual display types with little effort.

The stripchart can be u$éy all models, but more sophisticated graphics displays reaydilable, depending on

the model. For instance, the Dynamic Layers graphics program reads model state variables from a many-layered soil
physics model called Frost. The variables are used to geratiate series display of the ifbayers, a own in

Figure 4. This graphics program is generically useful for models that employ a similar spatial strutitie,imi
applicable to all models.

Figure 4. Snow, water, and ice content for simulated soil layers during the spring thaw of 1994. This Dynamic Layers
display, more sophisticated than the all-purpose WISE istripcharti visualization tool, scrolls as time progresses.

The reports are seto the simulation manager as they are requested. This allows the user to customize the look of
the display prior to runtime. Options for both the stripchart and the Dynamic Layers display include adjusting scaling
in the daa ais (vertical), selecting color for all components of the windowd egfining line atributes for the
stripchart (color, width, and style). While these may also be changed during the simulationdéa pause button allows for
a momentary cessation of data handlingéit is convenient to set things up beforehand as much as possible.



Finally, this implementation will perinthe inclusion of 3D graphics using OpenGL by taking advantage of the
ability to use OpenGL calls to drive a drawing area widget under Motif.

Post-processing
The stripchar option within WISE provides immedmt feedbak on selectd variables as the simulation

progresses, ltus not sufficien to give an overall picture of the model behavior. By using the WHIB& report

option for output, however, the required state variables are printed to a file at designated time steps as the model
runs The final output fié can then be usel by custom post-processing softwarwhich suppor datistics or
mathematical routines, GIS, or other types of analysis and visualization programs.

For example, Zelig, a gap moddlforest growth, was run for a simulati period o 250 years ¢ predict species
compositon basel onsal type and water saturation level for a site in Howland, Maine. The mibtairs ®veral

soil polygons , which & composé of a number of soil seres (e.g., Westbury, Colaneljhe model was
parameterized and runusing WISE for each soil series across the Howlan®stfmut data was generated for
species composition, average biomass, leaf area, stem density, and depth to water table, and printed to a file. A GIS
system was usea toltain a triangulatn o the Howland topographyna boundries for the soil polygons. Post-
processing software ingested both the GIS data and modeling output files, as well as mixing parameters for the soil
series within a polygon. Derived variables were then mapped to the soil polygons using a weighting algorithm based
on the composition of theseries . Figure XXXgives an example of the 3-d display derived drasmtiinaton o

Zelig model output using WISE for each soil series, and GIS.
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Using this method the WISE environment, &dlbugh no spatially expli¢t itself, can provide the meam to view
the model results in a way thes moe anenable to comparison with feeldata and is easily interprete by the
researcher.

Figure XXX. Example & 3-d display derived from tle combinaton o Zelig model output using WISE for each

soil series, and GISData from the Zelig model was captured at steps througtheusimulation. The software
supports animation of the step that one may see how the patterns change with tisteny pant, the viewing
parameters may be interactively changed by zoomotation. A clipphg ogion permits one to “chip' awayt ¢he

3-D data set to easily see the relationship of the water table and the soil surface. Tree species are colored according
to their water tolerancehe mos tolerant Northern whie celar, is pure blue, leass Eastern white pine which is
displayed a pure red, and the remaining species are ranked between these in varying propdnteshanc Hue

according to a measure of their water tolerance.

The PSE At Work: 2 Case Studies

Case Study 1. Linking Models Of Different Disciplines

Using WISE, we showed th#éhe dynamics of sbice ina complex soil model can be importato the timing and

amount of transpiration of water by foréees smulated for cold boreal regions (such as much of Alaska, Canada,

and Siberia). For example, simulations for a site in the US state of Maine, near the southern boreal forest boundary,
show marked effects of #dce in some years and not others. We simulated this with the Frost soil physics model,
and a vegetation model, Hybrid, in coupled and uncoupled modes.




The Frost simulation model estimateeveral values of interedo soil scientists, such as water content, matric
potential, temperature, andei ®ntent within each soil horizohFrost uses network analysis describe heat and
moisture transfer, and accounts for short-evavd long-wave radiative transfer, changes in energy status, surface
runoff, infiltration, redistribution, drainage, evaporation, transpiration, Penman demand, and snow. Daily input
requirements include global short-wave radiation, maximum and minimum air temperatures, average wind speed,
precipitation, and lower boundaryilstemperatue and water. Soil profile, site, and canopy characteristiesdan

needed. Frost is unique in that it simulates soil moisture and temperature flux at a greater level of detail, and canopy
processes at a more simplified level of detail, than most ecosysidels.

Hybrid is a numerical biogeochemical model of terrestrial ecosystem dyfamits features including fully
coupled carbon, water, and nutrient cycles within the soilfiplantfiatmosphere system; drivers and constraints for
climate, nitrogen deposition, and atmospheric, @@ Q; ard bah transient and equilibrium responses to climate
change.

Hybrid uses a flexible subdaily time step for cycling and exchange of carbon, nitrogen, and water, and for growth of
grass. Individubtree growth occurs on an anhtiane step. Individuatrees and grass compete for light, water, and
nitrogen within a patch or plot, resulting in smaller plants being shbgléarger ones, and larger plants takiy

more of tle available water and nitrogen. Theilsis represented as three layers with a simple daily hydrological
budget. Decomposition is calculated using an empirical submodel.

In the first months of 1994, early winter snows were light in east-central Maine and soils froze to a substantial depth.
Simulated latent heat fluxes from instances of Hybrid runningeadod coupled to Frost were similar for much of

the winter of 1994. However, during the spring thaw, the coupled model showed evaporation being restricted by soil
ice (see Figure 6, in which evaporation is proportional to the latent heat flux shown). In contrast, the Hybrid-only run
showed more soil moisture being lost to respiration during the thaw.
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Figure 6. Simulation results for coupled ecosysteodek $ow the usefulness of the WISE problem-solving
environment. Latent heat flux (associated with evaporation) prddigt¢he vegetation model Hybrid aloneHite

line) mostly agrees with predictions of Hybrid coupled with the soil-physics model Btastling. However, the

results diverge markedly during the spring thaw, with important consequences for the water and carbon balances the
rest of the year.

A consequence of this discrepancy is that months later in the simulation, Hybrid running alone predictedrdrough
August and September 1994, whereasdupled model (with its carry-over of winter precipitation in the form of

sal ice) showed sufficient soil moisture for plant growth during the whole summer season. The stand-alone Hybrid
simulation lost carbon (a measure of vegetation productivity), while the coupled model had a positive carbon balance
for 1994 cespite below-average rainfall. Because of these findings and rsieslalts for other boreal ecosystems,

we are exploring ways of including the effects of soil ice in global simulations with Hybrid.

Case Study 2. Deriving Improved Input Parameters For Standalone Models

Linking models from different disciplines is one way of assuring that the complexity required to describe ecosystem
conditions is adequately representetlaving 2 models running simultaneously, however, may be difficu
situations where resources are limited, and simulation time is important. Another way of addressing the problem of
adequately parameterizing a model of one discipline with the proper inputs of another is to link different models




intially, derive output parameters from the results of the linked models, amdstheritical output components as
inputs to a standalone model of a single discipline. An example of how WISE was used to accomplish this follows.

The dynamis of snow n rorthern forest ecosystems are impottaior accurately assessingettenergy budget

during initial snow fall, over the winter, and during snow melt. The amount and duration of ice as well as available
soil water are dependent upon the characteristics of snow fall at a given site. The FroST mode$ siraulatea

very simple way by modifying characteristics of the surface soil node and any snow covered canopy and litter nodes
to represen the daracteristics of a snow pack (i.e. short wave reflectivity and transmissivity, long wave
transmissivity, emissivity, bulk density, and thermal conductivity). Precipitation events increase the node thickness,
and a simple melt factor removes the snow. As the snow melts, node characteristics revert to that of the original soil
layer. Input values for the variables above are required to accurately represent snow characteristics for a given site.
Values can be obtained from literature research, from actual field measurements, or from output from a more
complex and rigorous snow model.

SNTHERM.89", is a one-dimensional mass and energy balancing model for predicting tenepeaatuiater

profiles through snow Snow and sib layers are subdivided into horizontally infaitontrol volumes which are

subjed to governing equations for heat and mass balali¢ater flow 5 smulated using a gravity flow algorithm,

with phase-changes, water flow, and tempeeatoupled by a freezing curve A range of winter conditions are
covered within the model including snow depth, rainfall, freeze-thaw cycles and transitions between snow cover and
bare soil. SNTHERM.89 also predicts snow accumulation and ablation, as well as snow density and metamorphosis
and thei result on optical and thermal process&espite its complexity in simulating snow conditions, the input

soil charactersitie and algorithms describing soil processes in SNTHERM.89 are much more simplisitic, and less
flexible for actual field conditions than are used in FroST.

For this case study, the goal of using WISE was to derive appropriate snow input parameters for specific climate and
site aonditions in Saskatchewan and Manitoba, Canada thatl ¢teulised to run the FroST mdde standalone

mode In the first step, WISE was used to run FroST in linked mode with SNTHERM.89. FroSt provided
SNTHERM.89 with information abdu soil moistue axd temperature changes for specific soil profile
characteristics over ¢hmurse of the simulation. SNTHERM.89 simulated snow conditiorts dffected the water

and heat fluxes in FroST. Since the basic time step for SNTHERM.89 is detkrhyirtbe time stp of the
meteorological data input, it was set to run on an hourly time step as is used in the FroST model. Input climate data
requirements for SNTHERM.89 were the ®arm that for FroST with # addition of approximat average
barometric pressure over the pefid the simulation, ngalR extinction coefficient for the top snow node, snow
albedo, and irreducible water saturation for snow. Output files of SNTH&RMedictions of snow density and
thermal conductivity over the simulation were generated from whiclm wedaes were determined. The mean snow
density and thermal conductivity information from the enaomplex snow model were theused as input
parameters for FroST’s simpler snow algorithms to allow FroST to run by itself.

Comparisons of snow depth were made between the FroST model results, with input parameters generated from the
linked simulation with SNTHERM.89, andata measured in 1994 at sites in Saskatchewan and Manitoba, Canada
that wee mllected as part of the Boreal Ecosystem Atmosphere Study (BOREABY using the linked models

predictel parameters, simulated snow depths agreed well with observed snow measrefoentl994
(Saskatchewarf £ 0.86, Manitoba= 0.92).

These case studies demonstrate some of many effects that can be explored and characterized with WISE that would
be difficult to study with less flexible approaches to coupling complex ecological models. By allowing these sorts of
modeling experiments, WISE can contributebetter understanding of ecosystem dynamics and help lead to more
informed choices about the management of ecosystems and global change. The WISE problem-solving environment
could also be adapted for research on other types of complex, heterogeneous systems in other disciplines.

The six-year-old WISE development prdjés made p of a smdl team of scientists and engineers that has varied
between two and five people. WISE runs on Sun architectures, specifically Berkeley and System V. Client software
is also compatible with HP-Unix, drpating to ather Unix platforns would be possible with modest effort. The



models vary in size and complexity but are typically a few thousand lines of code each. More information on WISE
and each of the models can be found at our Web site at httpuffedsfc.nasa.gov.
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